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Introduction

Thank you for purchasing FaceReader, the unique professional
system for detecting emotional expressions in the face. This
manual contains all the information you need to make the most of 
this powerfool tool. By way of introduction, this chapter describes
how to use the manual, and how to get additional support if
required. This chapter also contains an introduction to
FaceReader, an overview of what is new in FaceReader 2.0 and a
description of the limitations of the current version.

1.1 About this manual

The manual is written so that it is understandable without the
program in front of you, but it is probably more rewarding to try
out the procedures as they are described. You can use this manual 
in one of two ways:

· Read through the chapters relating to particular functions, to
get background information before using the program.

· Consult the manual as a reference document, to find out
particular information. You can find a topic either by consulting 
the table of contents (at the front of the manual) or the index
(at the end).
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If you prefer, this manual is also provided as a PDF (portable
document format) file. This file can be read and printed using
Adobe Acrobat® Reader, which you can download free of charge
from www.adobe.com. You can either copy the PDF file from the
installation CD to your hard disk, or open it directly from the
FaceReader installation CD.

All the information in this manual can also be found in the Online
Help. To access the Online Help from within FaceReader, press F1
or choose Help from the Help menu. Use the Contents, Index or
Search options to find specific help topics.

1.2 Typographical conventions

· Software elements (such as menus or commands) are shown
in bold.

· Keys such as F1 are also shown in bold.

· Functions that have task bar icons are indicated by the icon in
the margin.

o Check box options are indicated with a square.

m Radio buttons (only one item in a group can be selected at
once) are shown by a circle.

Warnings are indicated by a warning icon.
Ignoring warnings can lead to data loss or
damage.

Important information is shown by an information
button.

Tips and tricks are shown by a light-bulb and text in
italics.

6 FaceReader 2.0
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A reference to other documentation (than the
FaceReader manual) is indicated by this icon.

Details about hardware are shown using this icon.

1.3 How to get additional support

Online help

You can start the online help by pressing F1 or by selecting Help
in the Help menu. You can find help topics by selecting Contents,
or using the Index or Search function.

Help menu

FaceReader's Help menu contains the following options:

· Help topics – Starts the Online Help. On the start page you will 
find an overview of FaceReader. You can then select other
topics using the table of contents, index or search function.

· Quick Setup Guide – The Quick Setup Guide helps you to set
up your camera and lighting correctly. By default, the Quick
Setup Guide is shown every time you start FaceReader. 

· FaceReader Online – This is a link to the FaceReader section
on the Noldus website.

· FaceReader Support – This is a link to the Help desk section
on the Noldus website.

· Upgrade – If you click this option, the Upgrade Key dialog box 
opens. The dialog box contains your license number. It opens
automatically when you start FaceReader 2.0 for the first time
after installation and the system detects the old hardware key.
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· About – Choose this option to see details of exactly which
version of FaceReader you are using and the serial number of
your software.

Noldus Help Desk

If you have any problems, questions, remarks or comments,
please let us know. You can contact us via our website
(www.noldus.com/support) and fill out a Support Request Form
(preferred) or phone during working hours in two time zones. See 
Appendix B to get details on how to contact our support
department.

Please check the online help or this manual before
contacting our support department.

Please refer to the About Noldus - Contact us section on our
website (www.noldus.com) for other contact information.

1.4 An introduction to FaceReader

This section gives a general overview of what the FaceReader
program does. For a more detailed description of all its
functionality, please see chapter 3 - 7 in this manual.

What is FaceReader?

FaceReader is a program for facial analysis. It can detect
emotional expressions in the face. It can identify six basic
emotions: happy, sad, angry, surprised, scared, disgusted and a
neutral state.  Additionally, it can indicate the person's gender,
age, ethnicity, the amount of facial hair (beard and/or moustache) 
and whether the person is wearing glasses or not. The software
can also identify the subject.
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FaceReader data can be imported into The Observer, the leading
software package for the collection, analysis and presentation  of
observational data. This enables you to integrate FaceReader data
with other data, such as manually logged events, physiological
data and eye tracker data and to analyze the full context. For
instance, what user interface is the test participant looking at and
what part triggers an emotion. 

FaceReader can be used in a wide range of research areas:

· Psychology — How do people respond to particular stimuli, e.g. 
in cognitive research.

· Education — Observing students' facial expressions can support 
the development of educational tools.

· Human-computer interaction — Facial expressions can provide
valuable information about user experience.

· Usability testing — Emotional expressions can indicate the ease 
of use and efficiency of user interfaces.

· Market research — How do people respond to a new
commercial's design?

· Consumer behavior — How do participants in a sensory panel
react to a presentation?

How does FaceReader work?

The main problem in the analysis of facial expressions is how to
deal with variance in pose/orientation and lighting of the face.
The solution that FaceReader uses, is to classify faces in three
consecutive steps. Please see reference [1] - [3] on page 11 for
more information.

1 Face finding — The position of the face in an image is found
using a method called the Active Template Method (ATM). The
Active Template Method (which is similar to the
implementation described in [4]), places a template over an
image and calculates what the most likely position of the face
is. In FaceReader 2.0 a second algorithm for face finding has
been added, the Viola Jones cascaded classifier algorithm. This
algorithm takes over when the Active Template Method has
problems finding the face.
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2 Face modelling — In this step, a model-based method is used,
called the Active Appearance Model (AAM) [5], to synthesize
an artificial face model, which describes the location of 55 key
points in the face and the facial texture of the area entangled
by these points. The model uses a database of annotated
images and calculates the main sources of variation found in
the images. Principal Component Analysis compression is used 
to reduce the model dimensionality. New faces can then be
described as deviations from the mean face, using a vector. 

3 Face classification — The actual classification of the facial
expressions is done by training an artificial neural network [6],
which takes the above vector as input. As training material
nearly 2000 manually annotated images were used. The
network was trained to classify the six basic or universal
emotions described by Ekman [7]: happy, sad, angry, surprised, 
scared, disgusted and a neutral state.

FaceReader can recognize facial expressions with an accuracy of
89%. For some emotions the accuracy is higher, for others lower
(Table 1).
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Table 1 Horizontally: emotional expressions  scored
manually by the annotators of the Karolinska data set
[8]. Vertically: expressions scored by FaceReader [1,2].
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1.5 What's new in FaceReader 2.0

This section gives users of FaceReader 1.0 an idea of the
improvements in FaceReader 2.0. The changes include a revision
of the user interface and adding important new functionality.
Please see below for an overview of the new functionality.

New face models

New face models have been added to the software. It is now
possible to analyze Asian faces and face of children older than 3
years. Please note that the current FaceReader version is not
well-trained for analysis of East-Asian children.

Improved face finding and face modeling

The Active Template Method for finding the face is not the only
face finding method anymore. A second algorithm has been
added, the Viola Jones cascaded classifier algorithm. If the Active
Template Method has problems finding the face, the Viola Jones
algorithm takes over. That means that more faces are found.

Face modeling has also improved. FaceReader 2.0 tracks better
and can, therefore, cope better with (slowly) moving faces. Fast
movements are still a problem.

Select which part of the video (stream) will be analyzed

You can now select and analyze only the interesting parts in your
video. You can browse to the parts of interest in your video file or
wait till an interesting episode starts in your live video stream and
start the analysis at that point in time. In this way, you can analyze 
several interesting episodes in your video file or live video stream.

New graphs which you can use in your reports

New graphs are available in FaceReader 2.0. You can now view
Expression Graphs for each emotion. In an Expression Graph you 
can view one facial expression over time. FaceReader also
provides a Pie chart with the distribution of emotions in your
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data. You can save the Expression Graphs and Pie chart and use
them in your presentations and reports.

Log files in XML format

You can now save your analysis results in XML format. This is
especially useful if you want to import your FaceReader data into
The Observer, our software package for collecting and analyzing
observational data. If you want to import FaceReader data as
external data, you can still use the Detailed logs in text format.

New codec pack

FaceReader 2.0 now has its own codec pack. There is no
interference with The Observer XT MainConcept Decoder Pack
anymore.

1.6 Limitations of the current
version

The current FaceReader version has a number of limitations. It is
good to keep these in mind when you start working with
FaceReader.

· FaceReader is currently not trained to work with very young
children, below the age of 3.

· FaceReader 2.0 is not (yet) trained for analysis of children from
East Asia and South-East Asia. In contrast to the previous
version, FaceReader 2.0 works well with other children and East 
Asian and South-east Asian adults.

· Glasses may hinder classification. Especially thick and dark
frames can reduce performance significantly. A polarisation
filter on the camera can help to avoid reflections in the
glasses.
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· Pose, movement and rotation of the test person are limited.
The test person should stand or sit and look frontally into the
camera (angle < 30°).

· FaceReader requires strict light conditions. Please see page 27
for more information.

· The face should not be partially hidden, for instance by a hat or 
very heavy facial hair. It is also very difficult to classify a
person's facial expressions when he/she is eating, because the 
person's hand covers part of the face when he/she puts food 
in the mouth.

· FaceReader can analyze one face at once. If there are more
faces in an image, these can be analyzed in different runs,
provided that the positions do not change significantly.

Please contact us if any of the limitations above impede your
research.
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2

Installation

This chapter describes how to install FaceReader on your
computer. It also provides information how to set up your
hardware. 

Prior to installation, please check the packaging list to make sure
all the components are presents. If any of the components listed
is missing or damaged, please report this to us immediately.

The contents of your package differ for new and existing users:

· If you are a new user of FaceReader – You received the
FaceReader installation CD, this Reference Manual and a
hardware key.

· If you are upgrading from FaceReader 1.0 – You received the
FaceReader installation CD and this Reference Manual. You
also received a number to upgrade your current hardware key.
Hence, no hardware key is enclosed, because the one you
have is upgraded automatically when you start FaceReader for
the first time and enter the upgrade number.

FaceReader 2.0 will be installed next to FaceReader 1.0.
If you do not want two FaceReader versions on your
computer, you must de-install FaceReader 1.0 before
installing the new version.
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2.1 System requirements

Prior to installation, please check whether your computer meets
the system requirements for running FaceReader.

Operating system

Microsoft Windows XP or Windows Vista.

FaceReader has been thoroughly tested using a US English version 
of Windows XP Professional (with Service Pack 3) and Windows
Vista Business edition (with Service Pack 1). Like any software
package, it is possible that minor differences in the operating
systems of certain local language versions may affect how well
FaceReader runs. If you encounter a problem of this sort, please
contact Noldus Technical Support.

Computer

System requirements when using FaceReader stand-alone 

— on a computer with Windows XP:

· Processor: minimum Pentium 3, 600 MHz, Pentium Dual Core/
Dual Processor recommended

· Internal memory:  minimum 512 MB RAM, 2 GB recommended

— on a computer with Windows Vista:

· Processor: minimum 1 GHz

· Internal memory: minimum 1 GB RAM, 2 GB recommended

When using FaceReader in combination with The Observer:

· Minimum Pentium Dual Core, 2 GHz

· Internal memory: minimum 1GB RAM, 3 GB recommended
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Camera

USB camera with a resolution of at least 640 x 480 pixels or an
analog camera in combination with a framegrabber. When you
use a webcam, we strongly recommend that you use a
high-quality webcam. Simple webcams are not suitable.

You can also use a Firewire camera, but you need a program like
DVdriver to make it work. Please see page 54 for more
information about DVdriver.

2.2 Installing the FaceReader
software

First install the FaceReader software and then
connect the hardware key to your computer, not the
other way around.

Follow the steps below to install the FaceReader software:

1 Insert the FaceReader installation CD in the CD-ROM drive of
your computer. The setup program should start automatically.

If the program does not start automatically, select Run
from the Start menu on the Windows taskbar. Click
Browse and select the file Setup.exe from the CD drive. 
Click OK to run this file and start the installation.

2 On the Welcome screen (Figure 2.1) click Next.
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3 Read the License Agreement (Figure 2.2) carefully and click I
Agree to confirm that you accept its terms. Then click Next.
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Figure 2.2 FaceReader's License Agreement.

Figure 2.1 FaceReader's Welcome screen.



4 On the Select Installation Folder screen (Figure 2.3), you can
select the location in which you want to install FaceReader. We 
recommend that you install the program in the default folder
(C:\Program Files\Noldus\FaceReader 2).

To be able to install FaceReader in this folder, you
must have administrator rights, i.e. you are the
system administrator or you are a member of the
Windows group Administrators and have been
assigned administrator rights. Window Power Users
cannot install FaceReader.

5 On the Select Installation Folder screen (Figure 2.3), you can
also select whether you want to install FaceReader for yourself
or for anyone who uses the computer. Make your choice and
click Next.

6 In the next screen, you are asked to confirm the installation.
Click Next. 
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The installation of FaceReader starts. First, the drivers for the
hardware key (HASP Device drivers) are installed. When the
installation of the drivers is complete, you get a message. The
installation of FaceReader continues.

7 When the installation of FaceReader is complete, a message
will appear informing you that FaceReader has been
successfully installed. Click Close to exit.

In addition to the FaceReader software, a number of
sample images and video files is installed (in C:\
Program Files\Noldus\FaceReader 2\Examples).

2.3 Connecting and upgrading the
hardware key

First install the FaceReader software and then
connect the hardware key to your computer, not
the other way around.

Each FaceReader license comes with a hardware key. This is an
important piece of equipment: you can only use FaceReader when 
the hardware key is connected to your computer. Please keep this 
in mind and make sure that you do not lose the key!

Connecting the hardware key

Plug the key into an available USB port on your computer. If the
hardware key is correctly connected, a red light is visible inside
the key.

Please be careful with the hardware key. It is
sensitive and can be easily damaged.
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Upgrading the hardware key

If you are upgrading from FaceReader 1.0, and start FaceReader
2.0 for the first time after installation, the system automatically
detects the old hardware key and asks you to type the new
Upgrade Key number in the Upgrade Key dialog box. This
number is normally sent to you by e-mail or in your welcome
letter.

2.4 Setting up your hardware

FaceReader can only classify facial expressions correctly if it gets a 
good video image. Both the placement of the camera and the
lighting of the subject's face are of crucial importance in obtaining 
reliable classification results.

By watching FaceReader's image quality bar, you can
see whether your setup produces high-quality video.
Please see page 31 for more information about the
image quality bar.

Choosing your camera

FaceReader has been thoroughly tested with a Philips SPC 900NC
PC webcam and a Logitech Quickcam 4000 Pro. You can purchase  
both camera types from us or use another webcam with a
resolution of 640 x 480 pixels (or higher). Simple webcams are not 
suitable. You can also use an analog camera in combination with
a framegrabber.

You can also use a Firewire camera, but then you need a program
like DVdriver to make it work. See page 54 for more information
about DVdriver.

Camera setup

It is important to place the camera at a location that will give the
most steady frontal view of the subject's face throughout the
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experiment. The ideal position for the camera is directly in front of 
the test participant. If the subject faces a computer screen, the
camera can be placed either directly above or directly below the
screen. When placing the camera on top of the monitor, try to
position it slightly below eye level, either by raising the chair
and/or by lowering the monitor. When placing the camera below
the monitor, lower the chair to position the camera slightly below
eye level. The classification output may have a small bias towards
'angry' when the camera is placed on top of the monitor and a
small bias towards 'suprised' when the camera is placed below the 
monitor. This is due to the fact that people tend to tilt their head
when showing these emotions. Alternatively, a camera like the
Logitech QuickCam® Sphere™ (in Europe)/Orbit™ (in the US) can
be used for placement of the camera in the middle of the screen.

Adjusting your camera

It is important to adjust your camera to provide images with a
good contrast and brightness. You can adjust the contrast and
brightness by adjusting the hardware settings using the software
provided by the manufacturer of your camera. When adjusting
your hardware settings, do not pay attention to the lighting of the
background. Focus only on the face area of the image and ignore
a very light or very dark background.
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In Figure 2.4 you can see an example of a face image showing a
good contrast and lighting. Dark areas of the face (such as the
eyebrows and the pupils) are near-black and the lightest part of
the face (the eye whites) are nearly white. The intensity histogram 
(made of the face area only) (Figure 2.5) shows how the intensity
values fill the whole spectrum.
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Figure 2.4.

Figure 2.4 Image with a good
contrast and brightness.



Please note that it is not possible to view a histogram 
like the one above in FaceReader. If you want to view 
such a plot, you can use graphics software like
PaintShop Pro or Photoshop. To analyze video
images, first make a screenshot of the image of
interest.

The face area of the image in Figure 2.6 is overexposed. The
forehead and cheekbones are nearly white and show very little
texture. The histogram (Figure 2.7) shows how only the high
intensity part of the spectrum is filled. Decrease the brightness by
adjusting the hardware settings of your digital camera or decrease 
the aperture size of your analog camera to correct this problem.
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A very common problem is that the image has too little contrast
(Figure 2.8). Especially when the background is very dark or very
light and the camera is set to 'automatic', the face area of the
image will have a very low variability in intensity (a low contrast).
The contrast is too low when the face area of the image contains
no bright white and no deep black pixels. The intensity histogram

Reference Manual 25

Installation

Figure 2.8 Image with too little
contrast.

Figure 2.7 Intensity histogram of the image in 
Figure 2.6.



(Figure 2.9) shows that only the middle section of the spectrum is
filled. Correct this problem by adjusting your camera (increase the 
contrast).

When working with a subject with a dark or very pale skin color,
you may need to make some extra adjustments. The default
settings will often yield an image as shown below (Figure 2.10).
Although there are both dark areas and white areas (the eyes) in
the face, the skin itself shows too little variations in intensity. By
increasing the brightness (to make the face lighter) and
increasing the contrast (to increase the variation in skin tones)
you can correct this problem. For people with a very pale skin,
decrease the brightness and contrast.
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Figure 2.9 Intensity histogram of the image 
in Figure 2.8.

Figure 2.10 Image that is too dark.



The corrected image should look similar to the image below
(Figure 2.11). Pay special attention to the skin tones. The eye
whites may have less variation in intensity, but this is of lesser
importance. Similarly, for individuals with a pale skin, darker areas 
like the eyebrows may loose some detail.

Lighting setup

A good lighting setup is vital to get a good image. Diffuse frontal
lighting is desirable. The light intensity or color is less relevant.
Strong shadows or reflections should be avoided. If possible,
place the FaceReader setup in front of a window. Make sure that
any windows to the sides of the subject are blinded. Lights from
the ceiling, common in most buildings, will produce shadows
below the eyebrows and nose. If the subject faces a computer
screen, two lights to either side of the monitor will give good
performance under most circumstances (please see Figure 2.12).
You can purchase such lights from us. In situations where interior
lighting cannot be controlled, stronger lights (e.g., four 25W
fluorescent (TL) tubes) can be used to negate the effect of other,
undesirable, light sources.
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contrast and brightness.



To assess the quality of your (video) image, you can view
FaceReader's image quality bar. Please see page 31 for more
information.
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Analyzing facial
expressions

FaceReader can classify facial expressions either live or offline. In
a live setup a camera is connected to the computer with
FaceReader running, in an offline setup you open a video file or
image in FaceReader.

3.1 Selecting a face model

Before you can start analyzing facial expressions, you must select
the face model that best fits the faces that you are going to
analyze. You can choose from a list of six models:

· General 1 – This model has been trained on a very diverse
selection of images. This model works well under most
circumstances for most people.

· General 2 – Like the General 1 model, this model has also
been trained on a very diverse selection of images. Under
some variations of pose and lighting the General 2 model can
give better results than the General 1 model.
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· Below Screen Optimized – This model has been optimized
for a camera position below the monitor. It does not work well
with East Asian faces and children.

· EastAsian 1 –  Select this model to analyze East Asian faces,
for instance, Chinese or Japanese faces.

· EastAsian 2 – Like the EastAsian 1 model, this model has also
been trained with East Asian faces. Under some variations of
pose and ligting the EastAsian 2 model can give better results
than the EastAsian 1 model.

· Children – Select this model if your test participants are
children between the age of 3 and 10. The current FaceReader
version is not well-trained for analysis of East-Asian children.

From the Options menu, select Settings. Click Face Models in the 
list on the left and select the appropriate model from the
drop-down list. Then click OK.

3.2 Analyzing facial expressions

FaceReader can classify facial expressions either live using:

· A video signal from a camera (digital or analog) – See page 30.

or offline using:

· A digital video file – See page 33.

· An image – See page 35.

Analyzing faces using a camera

You can either use a digital camera or an analog camera (in
combination with a framegrabber) to analyze faces in FaceReader.
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If you use a digital camera, make sure that you have
installed the software that comes with your camera, and 
connect the camera to an available USB or FireWire port
on your computer (depending on the device). Please
note that you need a program like DVdriver when you
use a FireWire camera. See page 54 for more
information about DVdriver.

1 From the File menu select New Analysis and then Camera
Analysis. A window opens that allows you to select your
camera from a drop-down list (see Figure 3.1). Select your
camera and click OK.

o Change Default Settings – By default, FaceReader 
selects the highest possible resolution and
framerate. Select the Change Default Settings
check box if you want to use a lower resolution or
framerate.

o Use as Default Camera – Select this check box if
you always use the same camera. FaceReader
automatically selects the camera.

The camera view will appear in the Current Analysis window.
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2 Click the Start Analysis button to start the analysis of the facial
expressions. A block is added to the Analysis Overview with
the start time of the analysis interval (see Figure 3.2 for an
example of an Analysis Overview).

The name of the Start Analysis button changes into
Stop Analysis.

3 Make sure that the quality of the camera view is good. The
Image quality bar can help you to assess the quality of the
camera image. The image quality bar must look like the one in
Figure 3.3, that is, the colored bar must cross both dashed
lines.

If the quality of your camera image is not good
enough, the text 'Framing failed' (FaceReader cannot
find the face) or 'Modeling failed' (FaceReader cannot 
model the face) will appear in the Analysis
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Figure 3.3 The Image quality bar.

Figure 3.2 Example of an Analysis Overview.



Visualization window. Probably either the lighting of the 
test person's face or the position of the camera is not
optimal. See Section 2.4 for information how to improve
your setup.

4 Click the Stop Analysis button to stop the analysis. The End
time of the analysis interval is added to the Analysis
Overview.

5 Repeat steps 2-4 to analyze more episodes.

6 From the File menu select Save Analysis Results to save the
analysis results. For more information about (saving)
FaceReader log files, see page 43.

The data of all the blocks are saved in one log file. If
you log with a fixed interval, the text Not Analyzed will
appear in the log file for the time points that were not
analyzed. See the File Logging settings on page 76 for
more information on the option Log with a fixed
interval.

Click the Clear Logs button to delete the analysis results. The
analyzed intervals in the Analysis Overview will be deleted.

Analyzing faces in a video file

Please see Appendix A for an overview of the video
formats which FaceReader supports.

1 From the File menu, select New Analysis and then Video
Analysis.

2 Browse to the location on your computer where you stored
your video file. Select the video file name and click Open. The
first frame will appear in the Current Analysis window.

3 Use the slider and the video control buttons to position the
video file at the point where you want to start the analysis.
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· Play – Play the video file.

· Pause playback – When you click the Play button
it changes into the Pause Playback button. Click
this button to pause the video.

· Stop Playback/Rewind to beginning – Stops the
video and jumps to the start of the video.

· Step backward – Moves the video file one frame
back with each click of the button.

· Step forward – Moves the video file one frame
forward with each click of the button.

4 Click the Start Analysis button to start the analysis of the facial
expressions. A block is added to the Analysis Overview with
the start time of the analysis interval (see Figure 3.3 for an
example of an Analysis Overview).

The name of the Start Analysis button changes into
Stop Analysis.

FaceReader can only classify facial expressions if the
quality of the video is good. The Image quality bar
can help you to assess the quality of the video image. 
The image quality bar must look like the one in
Figure 3.2, that is, the colored bar must cross both
dashed lines. If the quality of the video is not good
enough, the text "Framing failed' (FaceReader cannot
find the face) or 'Modeling failed' (FaceReader cannot 
model the face) will appear in the Analysis
Visualization window.

5 Click the Stop Analysis button to stop the analysis. The End
time of the analysis interval is added to the Analysis
Overview.

6 Repeat steps 3-5 to analyze more episodes in the video.
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7 From the File menu, select Save Analysis Results to save the
analysis results. For more information about (saving)
FaceReader log files, see page 43.

The data of all the blocks are saved in one log file. For
the time points that are not analyzed, the text Not
Analyzed appears in the log file.

Click the Clear Logs button to delete the analysis results. The
analyzed intervals in the Analysis Overview will be deleted.

By default, the video is processed frame-by-frame. If you 
like to speed up the analysis, you can change the Video
Process Speed. See page 73 for more information.

Analyzing faces in images

Please see Appendix A for an overview of the image
formats which FaceReader supports.

1 From the File menu, select New Analysis and then Image
Analysis.

2 Browse to the location on your computer where you stored
your images. Select the images and click Open. The
last-selected image will appear in the Current Analysis
window.

3 Select the Analyse all images check box if you want to analyze 
all selected images.

4 Click the Start Analysis button to analyze the images. The
analysis results will appear in the Analysis Overview (see
Figure 3.4 for an example). For each image, the dominant
emotion is logged.
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FaceReader can only classify facial expressions if the
quality of the images is good. The Image quality bar
can help you to assess the quality of the images. The
Image quality bar must look like the one in Figure
3.2, that is, the colored bar must cross both dashed
lines. If FaceReader cannot analyze the face, the text
'Framing failed' (FaceReader cannot find the face) or
'Modeling failed' (FaceReader cannot model the face) 
will appear in the Analysis Visualization window and 
Unknown will appear in the Analysis Overview.

5 From the File menu, select Save Analysis Results to save the
analysis results. For more information about saving FaceReader 
log files, see page 43.

If you analyzed a series of images, the data of all the
images are saved in one log file.

Click the Clear Logs button to delete the analysis results. The
analysis results in the Analysis Overview will be deleted.
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4.3 Visualization options

The Analysis Visualization window gives you some insight in
how FaceReader analyzes your video images. Click the
Visualization button to select one of the options:

· Show Framing – Draws a box around the face at the location
where the face was found (see Figure 3.5).

· Show Model – Shows the model that has been constructed by
the face modeling algorithm (see Figure 3.6).
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· Show Mesh – Shows the positions of the 55 key points used
by the face modeling algorithm (see Figure 3.7).
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Figure 3.7 The Analysis Visualization window
when the option Show Mesh is selected.

Figure 3.6 The Analysis Visualization window
when the option Show Model is selected.



4

FaceReader's output

4.1 FaceReader's graphical output

· Emotional Expressions bar chart – See below.

· Expression Graphs – See page 40.

· Personal Characteristics – See page 41.

· Pie chart – See page 42.

Emotional Expressions bar chart

In the Emotional Expressions bar chart (see Figure 4.1 for an
example) you can see which of the six basic emotions (and the
neutral state) show up on the face. When your input is a live video 
stream or a video file, you will see the bars change over time,
reflecting the changes in emotions on the face. Each emotion is
expressed as a value between 0 and 1. Each time the dominant
emotion changes, a record with the emotion is added to the State 
log (see below for more information about the log files).
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Expression graphs

In an Expression Graph you can view one facial expression over
time. From the Window menu, select Expression Graphs and
choose the emotions you want to view. Each emotion is plotted in 
a separate window.

By default, only the Valence Expression Graph is visible (see
Figure 4.2 for an example). The valence indicates whether the
emotional status of the subject is positive or negative. 'Happy' is
the only positive emotion, 'Sad', 'Angry', 'Scared' and 'Disgusted'
are considered to be negative emotions.

Click the Save as image button to save the Expression graphs as
*.PNG, *.JPG, *.BMP, *.GIF or *.TIF images and use them in your
presentations and reports.

Click the Copy button to copy the Expression graphs to the
Windows clipboard.

From the Window menu, select Reset Window
Layout to close the Expression Graphs that you
opened extra and to reset the position of your
windows.
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Figure 4.1 Emotional Expressions bar chart showing the emotions
that are visible on the face.



Personal Characteristics

In addition to emotions, FaceReader can "read" other information
from the face: the subject's gender, age and ethnicity and
whether the person has a beard, moustache or glasses (see Figure 
4.3 for an example of the output given by FaceReader). For the
age a range is given, for gender, ethnicity and the presence of
glasses a certainty value (ranging between 0 and 100%). The
amount of facial hair (beard and moustache) is indicated by a
value between 0 and 100%.

The additional facial features also give you an indication 
of the quality of the image. If the quality of your image
is poor, the information will not be correct. For instance, 
if FaceReader reports that a female test person is male,
then the modeling is not correct, most probably because 
the image is of poor quality.
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Pie chart

Select one of the analysis intervals in the Analysis Overview to
view a pie chart with the distribution of emotions in your data.
See Figure 4.4 for an example.

Use the Ctrl and Shift keys to select multiple intervals 
and view a pie chart that is based on all these data.

Right-click on the chart and click

· Copy – To copy the chart to the Windows clipboard

· Save Image As – To save the chart in one of the following
formats: *.png, *.jpg, *.bmp, *.gif, *.tif, *.emf.

· Page Setup – To change the print properties. You can select,
for instance, whether you want to print the chart in landscape
or portrait view and set the margins.

· Print – To print the chart.

· Show Point Values – To view the subdivision of emotions in
percentages. Move with your mouse over the pie to view the
percentages. 
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4.2 FaceReader's numerical output -
log files

You can save your classification results in one or more log files, 
and open these files in other programs, either to view the data or
to analyze them. 

Saving your analysis results

1 From the File menu, select Save Analysis Results.

2 Browse to the location on your computer where you want to
store your log files and click OK. The default location is:

Windows XP: C:\Documents and Settings\All Users\(Shared)
Documents\Noldus\FaceReader\Logs

Windows Vista: C:\Users\Public\Documents\Noldus\
FaceReader\Logs
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3 Enter a name for your log files in the Save Logs window
(Figure 4.5). The default name for the log files is:

· SOURCE_YYYYMMDD_hhmmss_detailed.txt for the
Detailed log

· SOURCE_YYYYMMDD_hhmmss_state.txt for the
State log in text format and

· SOURCE_YYYYMMDD_hhmmss.odx for the
Observer log.

where SOURCE specifies the name of the camera, video file or
image that has been analyzed and YYYYMMDD_hhmmss is the
date/time code.

YYYY = year including the century

MM = month with leading zero

DD = day with leading zero

hh = hours, 12-hour format with leading zero

mm = minutes with leading zero
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ss = seconds with leading zero

4 In the Save Logs window, select one or more of the following
formats and click OK:

o Save detailed log (.txt) – See below for more
information about the Detailed log in text format.

o Save state log (.txt) – See page 46 for more
information about the State log in text format.

o Save Observer log (.odx) – By default, Observer
log contains information from the State log as well 
as the Detailed log. If you are only interested in
the State log data, you can de-select the Include
detailed values in Observer log check box. See
page 47 for more information about the Observer
log.

Detailed log

The Detailed log (see Figure 4.6 for an example) contains all the
emotional classifier outputs. When no face is found or the face
cannot be modeled (e.g. because the quality of the video is poor), 
a record with FIND_FAILED or FIT_FAILED is added. If you analyze
a video file and skip frames (that is, you set the Video Process
Speed to >1), the logging frequency changes accordingly. If you
work live (using a camera) and your computer cannot process the
incoming images fast enough, frames will be skipped and a
record with MISSING will be added to the Detailed log.

The Detailed logs are text files with the data separated by tabs.
You can view the data in most spreadsheet programs and text
editors, for instance, Excel or Notepad. You can also import
Detailed logs into The Observer XT, our software package for
collecting observational data. Please see page 58 for more
information about importing Detailed logs into The Observer XT.
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State log

The State log shows the emotional state the test person is in (see
Figure 4.7 for an example). A record is added to the log each time
the dominant emotion changes. If no face is found or  the face
cannot be modeled (for instance, because the quality of the video 
is poor), a record with UNKNOWN is added to the State log.

State logs are text files which you can open in most text editors.
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Observer log

The Observer log contains information from the State log as well
as the Detailed log, in XML format. Select this output format if you
want to import your data in The Observer, our software package
for collecting observational data. Please see page 55 for more
information about importing Observer logs into The Observer.
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5

Using FaceReader in
combination with       
The Observer XT

Integrating FaceReader data with other data may give you a more
complete picture of the phenomena that you are studying. For
instance, when testing your newly developed web site, it may be
interesting to know what emotions it evokes, but it may be even
more intriguing to see at what part of the web site your test
person is looking when his facial expressions are classified as
'happy' or 'surprised'. Manually logging the test person's verbal
reactions or measuring his physiological responses makes the
picture complete. For the integration of all these data, you can
use The Observer XT. 

The most convenient way to do this, is to make a video recording
of the test person's face, and analyze the video both in
FaceReader and The Observer. See Section 5.1 for the advantages
of this method.

Alternatively, you can use FaceReader live. You can start and stop
FaceReader from within The Observer: start classification when
you start an observation and stop classification when you stop the 
observation (see Section 5.2 for the steps to follow). In this way,
you can synchronize your FaceReader data with your manually
logged events.
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If you want to use the video signal from your camera both in
FaceReader and The Observer, you need to split it. See Section 5.3 
for the procedure to use DVdriver® for this purpose.

When the observation is ready, you can import FaceReader's log
files into The Observer and visualize the test person's facial
expressions together with your observational data. See Section 5.4 
for the procedure to follow.

5.1 Recording a video and
analyzing it both in FaceReader
and The Observer

You can make a video recording using the software provided by
the manufacturer of your digital camera. Alternatively, you can use 
an analog camera and encode the video to make a digital video
file.

Working with video instead of live has a number of advantages:

· You can analyze the video frame by frame. When you work
with a live video signal and log with a fixed interval of 5
frames/sec, FaceReader may skip frames if it cannot keep up
with the incoming information.

· You do not need to score live in The Observer with the risk that 
you miss important events. When you make a video, you can
play it multiple times and score in as much detail as you need.

· If you like, you can make more than one video recording. For
instance, a close-up recording of the test person's face (for
analysis in FaceReader) and a screen capture of the test
person's computer screen. You can open both videos in The
Observer.
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For more information about screen capture, please see
Section A.4 in The Observer XT 8.0 Reference Manual.

5.2 Starting and stopping
FaceReader from within The
Observer

The functionality to control FaceReader from within The Observer
enables you to:

· Start classification when you start an observation

· Stop classification when you stop an observation

Starting classification precisely when you start the observation,
has the obvious advantage that you synchronize your FaceReader
data with your manually logged events. 

For this functionality to work you must make settings in both
FaceReader and in The Observer.

Settings in FaceReader

1 From the Options menu, choose Settings and then click File
Logging from the list on the left. Select the options Log with a 
fixed interval and Allow external application commands.

2 Restart FaceReader.

Settings in The Observer XT 8.0

There is a template project on the FaceReader installation CD (in
the Documentation folder) in which the appropriate settings have 
already been made. You can either use this project or create a
new project and make the settings yourself following the
procedure below.

1 Create a new project.
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2 Click Observation Sources, select Live and then click Add
external program. The Add External Program window opens
(see Figure 5.1).

3 Make sure that Start Observation is selected in the Run
program at field.

4 Click the button next to the Select program to run field (see
the icon in the margin) and browse to the location where the
FaceReader program file (FaceReader.exe) is stored, by default
in

C:\Program Files\Noldus\FaceReader 2

5 Select the file and click Open.

6 In the Command line options field enter STARTOBS. This
instructs FaceReader to start analyzing when you start an
observation.

7 Click Add to add the setting to the Observation Sources list.
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8 Repeat Steps 3-7 for Stop Observation. Enter STOPOBS in the
Command line options field. This instructs FaceReader to stop
analyzing when you stop your observation.

You are now ready to set up your project in The Observer. For
more information, refer to The Observer XT Reference Manual.

1 When your project is ready, check that your camera is
connected to the PC and that it is turned on.

2 Start a new observation. Classification in FaceReader is
automatically started.

3 Score data in The Observer.

4 Stop the observation. Classification in FaceReader is
automatically stopped.

You can now save your classification results and import
FaceReader's log files into The Observer XT. Please see Section 5.4 
for the steps to follow.

5.3 Splitting the video signal and
analyzing it both in FaceReader
and The Observer XT

If you want to use a single video stream both in FaceReader and
The Observer XT, you need to split it. You can do this with
DVdriver®. Please contact us at info@noldus.nl for your personal
copy of this software.

You can also use DVdriver if you want to use a FireWire
camera in combination with FaceReader. Without a
program like DVdriver, FireWire cameras do not work.

1 Install the DVdriver software on your computer.
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If you work on a computer with Windows Vista, a
Windows Security window will pop up during
installation with the message that Windows cannot
verify the publisher of the driver software. Click
Install this driver software anyway.

2 Make sure that your camera is connected to the computer.

3 Right-click the DVdriver icon on your taskbar and select Load
Video Device and check whether your video camera is
selected. If necessary, select it from the drop-down list and
click OK.

Open the video in FaceReader:

1 From the File menu, select New Analysis and then Camera
Analysis. A window opens that allows you to select your
camera from a drop-down list.

2 Select DVdriver as your camera and click OK. The camera view
will appear in the Current Analysis window.

Open the video in The Observer XT 8.0:

1 Start The Observer XT and create a new project.

2 Click Observation Sources, select Live and then select
DVdriver in the list of devices.

3 Select Add external program to start and stop classification in
FaceReader from within The Observer XT. See page 51 for more 
information about this option and for the steps to follow.

You are now ready to set up your project in The Observer XT. For
more information, please refer to The Observer XT Reference
Manual.

1 When your project is ready, create a new observation. The
camera view will appear in the Videostreams window.

2 Start the observation. The time in The Observer XT starts
running and classification in FaceReader is automatically
started.
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3 Score data in The Observer XT.

4 Stop the observation. Classification in FaceReader is
automatically stopped.

5 You can now save your classification results and import
FaceReader's log files into The Observer XT. Please see Section
5.4 for the steps to follow.

5.4 Importing FaceReader log files
into The Observer XT 8.0

When you are ready classifying your test person's facial
expressions, you can import the log files into The Observer XT to
combine the data with your manually scored events and any other 
data that you imported (physiological data, eye tracker data etc.).
You can import both the Observer log and the Detailed log in The
Observer XT 8.0. 

Please contact Noldus Technical Support if you want to
import FaceReader log files into The Observer XT 6 or 7.

Importing Observer logs

When you save the FaceReader log files, you can choose whether
you save only the State log information or both the State log and
the Detailed log information. if you choose the latter, the Detailed 
log data will be saved as numerical modifiers. That means that
you can calculate statistics like, e.g., the mean and maximum
classification value for each of the emotions when you import the
log files into The Observer XT. Follow the steps below to import
FaceReader Observer logs:

1 Start The Observer XT, open the appropriate project or create a
new one. From the File menu, choose Import and then
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Observational Data. The Select Observational Data Files
window opens (see Figure 5.2).

2 In the Files of type field, select The Observer XT Data File
(*.odx) from the drop-down list.

3 Browse to the location on your computer where you stored
your log file, by default in:

· C:\Documents and Settings\All Users\(Shared)
Documents\Noldus\FaceReader\Logs (Windows
XP) or

· C:\Users\Public\Documents\Noldus\FaceReader\
Logs (Windows Vista).

4 Select the appropriate log file and click Open. The data are
imported into The Observer XT as a new observation named
'FaceReader data'.
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If you imported your log file into a project with an
existing coding scheme, it may be that the key codes 
of the emotions conflict with the key codes of the
behaviors that you defined previously. If this is the
case, you must redefine your key codes and make
them unique.

— If you imported State log information only

If you only saved State log information in your Observer log, the
new observation contains one Event File 'State log values'. When
you open the coding scheme, you will see that a behavioral group 
'Emotions' has been added with the six basic emotions, the
neutral state plus 'Unknown' as behaviors. 'Unknown' is the
emotion that is logged when FaceReader cannot find or model
the face.

You can now select your data, visualize them (see Figure 5.3 for
an example) and calculate statistics. Please see The Observer XT 8
Reference Manual for more information.

— If you imported both State log and Detailed log information

If you saved both State log and Detailed log information in your
Observer log, the new observation contains two Event Files: 'State
log values' and 'Detailed log values'. Two behavioral groups have
been added to the coding scheme:

· Emotions – This behavioral group includes the six basic
emotions plus the neutral state and 'Unknown' (the emotion
that is logged when FaceReader cannot find or model the
face).
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· Behavior root – This behavioral group contains the behavior
'Detailed expression values' to which 7 numerical modifier
groups are attached: one for each emotion.

You can now select your data and calculate statistics. For instance, 
select only that part of your observation when the test participant
looked at the home page of your newly developed web site and
calculate the mean classification values for each of the emotions
during this period.

Importing Detailed logs as external data

To be able to import FaceReader data as external
data, you need the 'External Data Module' of The
Observer XT.

When you import a Detailed log as external data, you
can view the data together with your manually scored 
events in The Observer XT, but you cannot calculate
any statistics. To be able to calculate statistics, you
need to save your data as an Observer log and select
the option Include detailed values in Observer log. 
See page 55 for information about importing
Observer logs.

On the FaceReader installation CD you will find an import profile
to import Detailed log files and a folder with the log file on which
the import profile is based. Follow the steps below to copy both
the import profile and the log file to your computer:

1 Browse to the Import profiles subfolder in the
Documentation folder on the FaceReader installation CD. 

2 Copy the import profile ('FaceReader 2.0 Detailed log as
external data.eip') to the default directory for import profiles:

· In Windows XP: C:\Documents and Settings\All
Users\ Application Data\Noldus\Common\Profiles.

· In Windows Vista: C:\ProgramData\Noldus\
Common\Profiles.
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as an Observer log and select the option Include
detailed values in Observer log. See page 55 for
information about importing Observer logs.

On the FaceReader installation CD you will find an import profile
to import Detailed log files and a folder with the log file on which
the import profile is based. Follow the steps below to copy both
the import profile and the log file to your computer:

1 Browse to the Import profiles subfolder in the
Documentation folder on the FaceReader installation CD. 

2 Copy the import profile ('FaceReader 2.0 Detailed log as
external data.eip') to the default directory for import profiles:

· In Windows XP: C:\Documents and Settings\All
Users\ Application Data\Noldus\Common\Profiles.

· In Windows Vista: C:\ProgramData\Noldus\
Common\Profiles.

The Application Data folder and ProgramData folder 
are hidden folders. To view these folders, click Start on
the Windows task bar, select (Settings and then)
Control Panel and double-click Folder Options. Click
the View tab and select the option Show hidden files
and folders. 

3 Create a new subfolder in the Application Data/ ProgramData
folder: 'FaceReader 2.0 Detailed log as external data'.

4 Copy the log file ('FaceReader 2.0 log_detailed.txt') from the
installation CD to the corresponding subfolder in the
Application Data/ProgramData folder.

You are now ready to import your log files into The Observer XT.

1 From the File menu, choose Import and then External Data.
The Import External Data window opens (see Figure 5.4).
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2 In the Files of type field, select FaceReader 2.0 Detailed log
as external data (*.txt) from the drop-down list.

3 Browse to the location on your computer where you stored
your log file, by default in:

· C:\Documents and Settings\All Users\(Shared)
Documents\Noldus\FaceReader\Logs (Windows
XP) or

· C:\Users\Public\Documents\Noldus\FaceReader\
Logs (Windows Vista).

4 Select whether you want to import the log file into an

m Existing observation or a
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m New observation

5 Select the appropriate log file and click Open. The data are
imported into The Observer XT.

You can now visualize your data and view your FaceReader data in 
the same plot as your manually logged events. See Figure 5.5 for
an example.
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6

Identification

In addition to classifying facial expressions and "reading" other
information from the face (like age, gender, etc.), FaceReader can 
recognize persons that have previously been added to a database. 
The identification functionality enables you to make a database of 
all the test persons that participate in your tests. You can
customize FaceReader's settings in such a way that the next time a 
person is tested, his/her name will automatically be added to the
Detailed log files.

You can use the identification functionality with images from a
digital video file (Section 6.1) or a camera (Section 6.2).

6.1 Adding a person to the
database

When using a video file

1 From the File menu, select New Analysis and then Video
Analysis.
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2 Browse to the location of the video file on your computer,
select the appropriate file and click Open.

3 From the Window menu, select Monitor identity. The Monitor
Identity window opens (see Figure 6.1).

4 Click the Start Analysis button in the Current Analysis window. 
The video will start to play and FaceReader starts its analysis. As 
soon as 5 frames have been analyzed, the Add this person
button in the Monitor Identity window will become available
and 'unknown person' will appear in the Monitor Identity
window (see Figure 6.2).

5 Click the Add this person button. The Add person to
database window opens (see Figure 6.3).
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Figure 6.1 The Monitor Identity window when waiting for the
video to start.

Figure 6.2 The Monitor Identity window reporting that the test 
person is not (yet) in the database.



6 Enter the name of the person in the video and click OK. The
name will appear in the Monitor Identity window and is added 
to the database, together with the first 5 images that have
been analyzed.

Click the Reset button to restart the person identification routines. 
The Monitor Identity window will change into the one in Figure
6.1 and identification starts anew.

When using a camera

1 From the File menu, select New Analysis and then Camera
Analysis.

2 A window opens that allows you to select your camera from a
drop-down list. Select your camera and click OK.

3 From the Window menu, select Monitor identity. The Monitor 
Identity window opens (Figure 6.1).

4 Click the Start Analysis button in the Current Analysis window. 
FaceReader will start its analysis. As soon as 5 frames have
been analyzed, the Add this person button becomes available
and 'unknown person' appears in the Monitor Identity window 
(see Figure 6.2).

5 Click the Add this person button. The Add person to
database window opens (Figure 6.3).

6 Enter the name of the person in front of the camera and click
OK. The name will appear in the Monitor Identity window and

Identification

Reference Manual 65

Figure 6.3 The Add person to database window.



is added to the database, together with the first 5 images that
have been modeled.

Use the Reset button to re-start the person identification routines. 
The Monitor Identity window will change into the one in Figure
6.1 and identification starts anew.

6.2 Monitoring the identity of a
person

When you have added your test persons to the database,
FaceReader will recognize them the next time they appear in a 
(live) (video) image (provided that they did not change too
much!). To monitor the identity of your test persons, follow steps
1-4 in Section 6.1 or Section 6.2. As soon as 5 frames have been
analyzed, a prediction of the current person's identity will be
made and the name will appear in the Monitor Identity window.
The frames will continuously be refreshed and guesses at the
person's identity will keep being made.

Select the option Write identity label to the log in the
File Logging settings to add a column with the test
person's name to your Detailed log files.

6.3 Renaming persons in the
database

If you accidentally entered the wrong name for a test participant,
you can rename it.

1 From the Window menu, select Monitor identity. The Monitor
Identity window opens (Figure 6.1).
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2 Click the Modify database button. The Modify identity
database window opens.

3 Right-click the appropriate name in the list and click Rename
Person. The Rename person window opens.

4 Enter the correct name and click OK.

6.4 Removing persons from the
database

To remove a person from the database:

1 From the Window menu, select Monitor identity. The Monitor
Identity window opens (Figure 6.1).

2 Click the Modify database button. The Modify identity
database window opens.

3 Right-click the appropriate name in the list and click Remove
Person. The person and all his/her images will be removed
from the database.

6.5 Removing images from the
database

There may be several reasons why you would like to remove
images from the database. If you stored, e.g., images showing the 
test participant with his/her eyes closed, it is better to remove
them because they will negatively affect identification. 
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It may also be that you linked images to the wrong name. When
adding a person to the database, FaceReader does not give a
warning if the name you enter is already in the database. If you
accidentally add, for instance, two times "Donna Smith" to the
database for two different persons, FaceReader will link the
images of the two persons to the name "Donna Smith". You can
use the steps below to delete the images that have been linked to 
the wrong name:

1 From the Window menu, select Monitor identity. The Monitor
Identity window opens (Figure 6.1).

2 Click the Modify database button. The Modify identity
database window opens.

3 Right-click the appropriate name in the list. The images that are 
linked to the name will appear.

4 Right-click the appropriate image and click Remove Image.
The image will be removed from the database.
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7

Settings

This chapter gives an overview of all the settings that you can
make in FaceReader. There are seven categories of settings:

· General settings — View your license info and hide the Quick
setup guide. See page 70.

· Face Model settings — Choose which model will be used for
finding, modeling and classifying faces. See page 71.

· Analysis settings — Specify the speed of video processing. See 
page 72.

· Identification settings — Enable person identification, specify
to match only with persons in the database, whether or not to
ignore recently added persons and how to deal with images of 
poor quality. See page 74.

· File Logging settings — Set FaceReader to log with a fixed
interval or accept external application commands. Specify
which additional parameters you want to add to the Detailed
logs (personal characteristics, identity label, image quality
value or valence value). See page 76.

· Visualization setting — Set FaceReader to play your video
continuously. See page 79.

· Advanced settings — Use the Advanced settings only at the
advice of Noldus or if you have experience with face
recognition algorithms. See page 80.

From the Options menu, select Settings to view the settings.
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By resting with your mouse on an item in the
settings, additional information will appear as shown
in Figure 7.1.

Click the Reset to default button to undo the
changes you made in the settings and go back to the
default settings.

7.1 General settings

In the General settings you can view your license info.

o Show Quick setup guide when FaceReader starts. The Quick 
Setup guide helps you to set up your camera and lighting
correctly. By default, the Quick setup guide is shown every
time you start FaceReader. Clear the check box to start
FaceReader without the Quick setup guide.

Default setting — Option selected.
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7.2 Face Model settings

Active Model

In the Face Model settings you can choose the model that will be
used by FaceReader for finding. modeling and classifying faces.
You can choose between six models:

· General 1 – This model has been trained on a very diverse
selection of images. The model works well under most
circumstances for most people.

· General 2 – Like the General 1 model, this model has also
been trained on a very diverse selection of images. Under
some variations of pose and lighting the General 2 model can
give better results than the General 1 model.

· Below Screen Optimized – This model has been optimized
for a camera position below the monitor. It does not work well
with East-Asian faces and children.

· EastAsian 1 –  Select this model to analyze East Asian faces,
for instance, Chinese or Japanese faces.

· EastAsian 2 – Like the EastAsian 1 model, this model has also
been trained with East Asian faces. Under some variations of
pose and lighting the East Asian 2 model can give better
results than the EastAsian 1 model.

· Children – Select this model if your test participants are
children between the age of 3 and 10. The current FaceReader
version is not well-trained for analysis of East-Asian children.

Default setting — General 1 is selected.

Model behaviour
o Dynamic updating (increased speed) — With this option

selected, FaceReader does not search for the face in the whole 
video image, it only looks in that part of the image which
contained the face in the previous image plus 30%. In
addition, in the face modeling step, the program does not start 
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modeling with the average face as a base, instead it uses the
face in the previous image. With the option Dynamic updating 
selected FaceReader can analyze faces at a much higher frame 
rate (up till 5 times faster). 

Default setting — Option selected.

7.3 Analysis settings

Classification
o Smoothen classification values — With this option enabled,

classification values are transformed to obtain a smooth output 
signal. Disabling this option will give you the raw output data.

If you are analyzing a set of images where each
image shows a different person or facial expression,
this option has no effect.
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Default setting — Option selected.

Video

Video Process Speed — By default, the video is processed
frame-by-frame, that is, the Video Process Speed is 1. If you like
to speed up the analysis and change the Video Process Speed to
2 or 3. If the Video Process Speed is 2 every second frame in the
video is processed. If the Video Process Speed is 3, every third
frame.

Default setting — Speed 1 is selected.
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7.4 Identification settings

Basic settings
o Enable person identification – Select this option to enable

the identification functionality.

Default setting – Option selected.

o Always find the best match – If this option is selected,
FaceReader identifies people by choosing from the list of
persons that have been added to the system. With the option
disabled, FaceReader also considers the possibility that the
person in the (video) image is a new, unknown person.

Default setting — Option selected.

Data storage location

Click the button in the margin to browse to the location where
you want to store the identity profiles. 

When you add a new face to the database,
FaceReader stores 5 video images on your computer.
These images make up the identity profile.

The default location for the identity profiles is

· C:\Documents and Settings\<username>\Local Settings\
Application Data\Noldus\FaceReader\identityprofiles (Windows 
XP)

· C:\Users\<username>\AppDate\Local\Noldus\FaceReader\
Identityprofiles (Windows Vista)

Finetune settings
· Avoid matches to recently added persons — People tend to

change in appearance only gradually. Someone who has been
added to the database several years ago will have changed
more than someone who has been added to the system an
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hour ago. This option allows you to change the extent to which 
this fact is being considered:

· 0 - not important

· 1 - little important

· 2 - medium important

· 3 - important

· 4 - very important

· 5 - extremely important

Default setting — 0 - not important

· Acceptable False Positive Rate — FaceReader can make two
types of identification errors. Firstly, an unknown person can
be incorrectly identified as someone already in the data set
(false positive). Secondly, a known person may not be
recognized as such and may be considered as an unknown
person (false negative). This option allows you to specify the
false positive rate that you find acceptable. You can enter a
value between 0.01 and 0.5.

Default setting — 0.08

· Force matches when model quality is poor — This option
allows you to specify how important it is that FaceReader
makes matches if the quality of the appearance model is poor:

· 0 - not important

· 1 - little important

· 2 - medium important

· 3 - important 

· 4 - very important

· 5 - extremely important

Default setting — 3 - important
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7.5 File Logging settings

Camera
o Log with a fixed interval – If this option is selected, an update 

to the Detailed log will be made every 200 milliseconds. If your 
computer cannot process the incoming images fast enough,
frames will be skipped and a record with MISSING will be
added to the Detailed log.
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When you analyze faces in a video file, FaceReader
always logs with a fixed interval. Depending on your
Video Process Speed, FaceReader analyzes the video
images frame-by-frame or every second frame or third
frame.

To be able to import the Detailed log into The Observer, 
you must log with a fixed interval.

Default setting – Option selected.

o Save live results to .txt file (camera only) – With this option
selected, FaceReader logs the data as soon as they become
available. It does not wait till the session has ended. 

The (Detailed) log can be accessed real-time by other
applications. This makes that FaceReader can be used
for research into affective computing and the design of
adaptive interfaces. In other words, FaceReader allows
other programs to respond instantaneously to the
emotional state of the test participant.

Click the button in the margin to browse to the location where
you want to store the live results. The default directory is 

· C:\Documents and Settings\All Users\(Shared)
Documents\ Noldus\FaceReader\Logs\Live Results 
(Windows XP) or

· C:\Users\Public\Documents\Noldus\FaceReader\
Logs\Live Results (Windows Vista)

Default setting – Option not selected.

External applications
o Allow external application commands — Select this option if

you want to start and stop classification from an external
application (for instance, The Observer). Please see Chapter 5
for more information about using FaceReader in combination
with The Observer.
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You need to restart FaceReader after selecting this
option.

Default setting — Option not selected.

Log values

By default, the Detailed log contains the classification output
values for the six basix emotions and the neutral state. Select one
of the options below to add extra information to the log file.

Default settings - Options not selected.

o Write personal characteristics to the log – With this option
selected, 6 extra columns are added to the Detailed log:
'Gender' (male/female), 'Bearded', 'Moustache', 'Glasses', 'Age'
(an estimation of the test person's age) and 'Ethnicity'
(Caucasian, Eastern Asian, African, South Asian or Other). For
'Bearded', 'Moustache' and 'Glasses', a value between 0 and 1
is given. 

o Write identity label to the log — If the person identification
functionality is enabled, you can select this option to add the
name of the test person to the log file.

o Write image quality to the log – The image quality is
indicated by a value between 0 and 1.

o Write valence value to the log file – If you select this option
the valence is added to the log file, indicating whether the
facial expressions are positive or negative and to what degree.
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7.6 Visualization setting

Video
o Repeat video — This option is for demonstration purposes

only. if you select this option your video is played continuously.

Default setting — Option not selected.
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7.7 Advanced settings

We recommend that you use the advanced settings only at the
advice of Noldus, or if you have experience with face recognition
algorithms. To view the Advanced settings, select the Show
advanced options checkbox in the Settings window.
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Advanced Settings Presets
· Preset for face finding settings — Changing this preset will

change the Size of Interest (the size of the frame that moves
over the video image searching for the face, see page 84). By
default, FaceReader starts searching for the face with a frame
size that is 11% of the video image size (minimum face
fraction = 0.11). It searches the whole video image and if it
does not find the face, it increases the frame size with 10%
(face size scaling factor = 1.10) and searches again.
FaceReader increases the frame size 10 times (number of face
scaling steps = 10) and goes on searching until the face
fraction is 0.30 (maximum face fraction). Changing one of the
Size of Interest settings, sets the Preset for face finding
settings to [custom].

Settings
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Make sure that the Size of Interest is comparable to the size
of the face in the video image. Choose one of the following
options:

· Find all faces (slow) — Select this option if the
default setting does not work properly or if you
want to include faces from people who sit a bit far 
from the camera. With this option selected, the
minimum face fraction is 0.08, the maximum face
fraction 0.30, the face size scaling factor 1.10 and  
the number of face scaling steps 13. Because
FaceReader starts searching with a smaller frame,
it takes longer to search the whole video image
than with the default setting. 

· Find medium size faces — This is the default
setting which normally works fine when the test
person sits at a normal distance from the camera.
With this option selected, the minimum face
fraction is 0.11, the maximum face fraction 0.30,
the face size scaling factor 1.10 and the number
of face scaling steps 10.

· Find large faces only (fast) — Select this option if 
speed of classification is very important and you
only have close-up images of your test persons.
With this option selected, the minimum face
fraction is 0.20, the maximum face fraction is 0.30, 
the face size scaling factor is 1.10 and the number 
of face scaling steps is 4.

Default setting — Find medium size faces.

· Preset for face modeling settings — Changing this preset will
change the Number of model fit iterations (see page 84).
You can also change the Number of model fit iterations
directly. If you do so, the Preset for face modeling settings is 
set to [custom]. Choose one of the following options:

· Maximum accuracy (slow) — This sets the
Number of model fit iterations to 12.

82 FaceReader 2.0

Chapter 7



· Medium accuracy — With this option selected, the 
Number of model fit iterations is 8.

· Low accuracy (fast) — This option sets the
Number of model fit iterations to 5.

Default setting — Medium accuracy.

Area of Interest

By setting the Area of Interest, you can crop the video image and 
only analyze that part of the image that contains the face. In this
way, you can decrease the area to search in the face finding step
and, thus, increase the speed of classification. This setting is also
useful for video images that contain two or more faces. You can
"cut out" the face that you want to analyze and ignore the other
faces or analyze them later.

· Bottom border fraction — Percentage of the bottom part of
the image to ignore when searching for faces. 

· Left-side border fraction — Percentage of the left side of the
image to ignore when searching for faces.

· Right-side border fraction — Percentage of the right side of
the image to ignore when searching for faces.

· Top border fraction — Percentage of the top part of the image 
to ignore when searching for faces.

Accepted values: 0 - 0.5

Default values: 0.01

Face Finding
· Minimum face detector classifier score — Minimum

classification score for a face to be considered a true instance
of a face. If you use the default setting of 0.50, FaceReader will 
report that it cannot find a face if the detection score is lower
than 0.50. If the score is higher than 0.50, FaceReader will
report to the face modeling step that it has found a face. It is
useful to increase this value if FaceReader finds false positive
faces (for instance, if it finds a face in the background where
there is none).
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Accepted values: 0.50 - 0.99.

Default value: 0.50

Face modeling
· Number of model fit iterations — Number of updates of the

appearance model. FaceReader starts with an "average" face
and updates this in a number of steps (iterations) so that it
resembles the face of the test person. Higher values give a
more accurate fit. You can set the Number of model fit
iterations by clicking the up and down arrows or by changing
the Preset for face modeling settings (see page 82).

Accepted values: 0 - 20

Default value: 8

Size of Interest

You can set the Size of Interest either by clicking the up and
down arrows or by changing the Preset for face finding settings
(see page 81).

· Minimum face fraction — Minimum fraction of the face
surface relative to the entire image surface.

Accepted values: 0.01 - 1

Default setting: 0.11

· Maximum face fraction — Maximum percentage of the face
surface relative to the entire image surface.

Accepted values: 0 -1 

Default value: 0.30

· Face size scaling factor — Factor by which the face surface is
increased between the minimum and maximum face size.

Accepted values: 1.01 - 2
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Default value: 1.10

· Number of face scaling steps — Number of steps when
scaling from minimum to maximum face size.
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A

Video and image formats

Video formats

FaceReader supports the following video formats:

Container Code Name/Encoder

mpg mpg1 MPEG-1 Part 2

mpg mpg2 MPEG-2

vob (DVD) mpg2 MPEG-2

mp4 mp4v MPEG-4 Video

mov mp4v MPEG-4 Quicktime

avi XVID XviD ISO MPEG-4

avi XVID XviD 1.1.0 Final

avi

avi

DIB (_RGB)

DIV3

BI_RGB Raw Bitmap

 DivX 3 Low-Motion

avi DIV5 DivX 5.x/6.x
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Container Code Name/Encoder

avi

avi

avi

avi

avi

avi

avi

avi

avi

avi

asf (.wmv)

asf (.wmv))

asf (.wmv)

asf

3gp

DIVX

dvsd

DX50

DX50

CRAM

cvid

IV32

MJPG

MP42

WMV3

WMV1

WMV2

WMV3

MP43

s263

DivX 4

DVC/DV Video

DivX 6.0.0

DivX 5.x

Microsoft Video 1

Cinepak

Indeo 3.x

Motion JPEG

S-Mpeg 4 version 2

WMP v9 (VC-1 Simple/Main)

WMP v7

WMP v8

WMP v9 (VC-1 Simple/Main)

S-Mpeg 4 version 3

ITU H.263 video (3GPP)

If you are not sure what the format of your video files 
is, you can use a program like GSpot to find this out.
Browse to www.headbands.com/gspot to download
GSpot (free of charge).
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For a number of other formats, codecs are included, but these
formats have not been tested. We can, therefore, not guarantee
that they work.

Container code Name/Encoder

avi DIV1, DIV2, mp41,
MPG4, MPG3

Divx (1,2,3)

avi DIV4, DIV6,
col1,col0,3ivd

DivX 4, 5, 6, 3ivx D4,
MPEG-4

avi h261 H.261

avi h262 H.262

avi h263 H.263/H.263i

avi h264, s264, AVC1, 
DAVC, H264, X264, 
VSSH

avi IV31 Indeo Video 3

avi mp4s, m4s2, fmp4, 
3iv2, smp4

MPEG-4 Part 2 (AVP),
Xvid

avi SVQ 1 Sorenson 1
(Quicktime)

avi SVQ 3 Sorenson 3
(Quicktime)

avi VP31, VP30, VP3 On2 VP3

avi VP50, VP5, VP51 On2 VP5

avi VP60, VP61, VP62,  
VP6F, VP6A

On2 VP6 (used by
FLV)
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Container Code Name/Encoder

flv FSV1 Flash Screen Video

mpg mp2v, mpg2, vcr2, 
hdv1, hdv2, hdv3, 
mx*n, mx*p

MPEG-2 Part 2

mpg mpeg, mp1v, PIM1 MPEG-1 Part 2

rm RV10, RV13, RV20 Real Video 1.0, 1.3,
2.0

wmv wmv1, wmv2 WMV 1/2 (7/8)

wmv wmv3, wvc1, wmva WMV 3/WMV-9/VC-1*

* Not all profiles are supported.

Video formats that are not supported (codecs are not included
and installing the codecs yourself will not work):

Container Code Name/Encoder

avi IV50, IV51 Indeo 5.x

avi tscc TechSmith Screen
Capture

avi IV41 Indeo 4.x

avi I263 H.263

avi cvid(_RGB) BI_RGB Raw Bitmap

avi (_RGB) BI_RGB Raw Bitmap
(8bit)
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Container Code Name/Encoder

mp4 avc1 H.264/MPEG-4 AVC

mov 3IV1 3ivx (MPEG-4 based)

mov avc1 H.264

mov svq3 Unknown

mov avc1 H.264/MPEG-4 AVC

Image formats

FaceReader supports the following image formats:

· JPG

· BMP

· GIF

· TIF

· PNG

Animated GIFs are not supported, FaceReader uses the first frame
of the animated GIF.

The minimum dimensions of your images should be about 640 x
480 pixels (200 x 200 for the face area). For FaceReader to work at
a reasonable speed, the maximum dimensions should not be
greater than about 2000 x 2000 pixels.
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B

Technical Support 

B.1 Help Desk

If you have any problems, questions, remarks or comments,
please let us know. You can contact us via our web site
(www.noldus.com) and fill out a Support Request Form
(preferred), phone during working hours in two time zones or fax.

Please check the online help or reference manual
before contacting our support department. Press F1 to
start the help, then type in the index a keyword related
to what you are having problems with.

Before you contact Technical Support, please have the version
number and license number of your copy of FaceReader available. 
To find these numbers, from the Help menu select About.

Please refer to the About Noldus - Contact us section on our web 
site (www.noldus.com) for other contact information.
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B.2 Service contracts

Your license of FaceReader comes with a standard service contract 
of one year. We also recommend a training upon installation of
FaceReader.

We can offer you even greater value and reassurance by providing 
comprehensive service contracts. Our Plus and Premium service
contracts both extend the standard service you are entitled to as
well as provide peace of mind at reasonable cost.

Please look on our web site (www.noldus.com) in the Services -
Service contracts section for more information.
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C

License Agreement

1 LICENSE. Noldus Information Technology b.v. ('Noldus') grants
you a non-exclusive license to use the software and
accompanying documentation (collectively called the 'Software' 
in this agreement) in accordance with the following terms.
Noldus retains title and all ownership rights to the Software.
Noldus will allow you to make back-up copies of the Software,
always including copyright notices, provided that these copies
are only for your own use. Noldus grants you the right to
transfer this license and the Software to another party,
provided that 9a) the other party accepts all terms of this
agreement, (b) all copies of the Software are transferred, (c)
Noldus is promptly notified of the license number of the
Software and the name and address of the other party, and (d)
Noldus is not required to supply new media. You may not
sublicense, assign or transfer the license or the Software
except as expressly provided in this agreement. Any attempt
otherwise to sublicense, assign or transfer any of the rights,
duties or obligations hereunder is void. You may not receive
money or any other form of compensation for transferring the
license.

2 TERM AND TERMINATION. Failure to comply with any of these
terms will terminate this agreement and your right to use the
Software. You may also choose to terminate the agreement at
any time. Upon termination of this agreement, you must
immediately destroy the Software and all copies of it.
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3 LIMITED WARRANTY. Noldus warrants that the media on which
the Software is furnished are free of defects in workmanship
and material under normal use, and that the Software will
perform substantially in accordance with the specifications set
forth in the documentation provided with the Software, for a
period of ninety (90) days from the date of purchase by you.
During the 90-day warranty period, if the Software does not
perform as warranted, Noldus at its sole option will (a) provide, 
without charge, a replacement of the media, (b) provide,
without charge, corrected Software, (c) replace, without
charge, Software with a functionally similar program, or (d)
refund the fees paid for licensing the Software. These are your
sole and exclusive remedies for any breach of warranty. Do not 
return any product until you have called Noldus or its supplier
and obtained a return authorization number.

4 DISCLAIMER. Software is licensed 'as is' without warranty as to
its performance. Except for the limited warranty provided
above, there are no warranties expressed or implied, including
but not limited to implied warranties of merchantability or
fitness for a particular purpose, and all such warranties are
expressly disclaimed. In no event shall Noldus or its suppliers
be responsible for any indirect or consequential damage or
lost profits, even if Noldus and its suppliers had been advised
of the possibility of such damage.

5 OTHER SOFTWARE. FaceReader 2.0 contains the following
components for which additional agreements must be agreed
upon:

· Open Source Computer Vision Library – Face detection

Intel License Agreement

For Open Source Computer Vision Library

Copyright © 2000-2006, Intel Corporation, all rights reserved.
Third party copyrights are property of their respective owners.

Redistribution and use in source and binary forms, with or
without modification, are permitted provided that the following 
conditions are met:
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· Redistributions of source code must retain the
above copyright notice, this list of conditions and
the following disclaimer.

· Redistributions in binary form must reproduce the
above copyright notice, this list of conditions and
the following disclaimer in the documentation
and/or other materials provided with the
distribution.

· The name of Intel Corporation may not be used to 
endorse or promote products derived from this
software without specific prior written permission.

This software is provided by the copyright holders and
contributors "as is" and any express or implied warranties,
including, but not limited to, the implied warranties of
merchantability and fitness for a particular purpose are
disclaimed. In no event shall the Intel Corporation or
contributors be liable for any direct, indirect, incidental,
special, exemplary, or consequential damages (including, but
not limited to, procurement of substitute goods or services;
loss of use, data, or profits; or business interruption) however
caused and on any theory of liability, whether in contract, strict 
liability, or tort (including negligence or otherwise) arising in
any way out of the use of this software, even if advised of the
possibility of such damage.

Runtime Modules of IBM High Resolution Time Stamp.
Copyright © IBM Corporation 2001. All rights reserved.

· FFmpeg - video file decoding

FFmpeg is free software: you can redistribute it and/or
modify it under the terms of the GNU Lesser General Public
License as published by the Free Software Foundation, either 
version 3 of the License, or (at your option) any later version.

The full text of the GNU Lesser General Public License can be 
found at http://www.gnu.org/licenses/lgpl-3.0.txt

Source code is available at at http://ffmpeg.mplayerhq.hu/
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· ZedGraph – pie charts

ZedGraph is free software: you can redistribute it and/or
modify it under the terms of the GNU Lesser General Public
License as published by the Free Software Foundation, either 
version 3 of the License, or (at your option) any later version.

The full text of the GNU Lesser General Public License can be 
found at http://www.gnu.org/licenses/lgpl-3.0.txt

Source code is available at http://sourceforge.net/projects/
zedgraph/
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